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ABSTRACT
The purpose of this paper is to communicate to SAS users the broad range of Options contained within SAS
Enterprise Guide. Located under the Tools menu, the Options item on the dropdown list provides a diverse
assortment of settings available for specialized application development. Choices offered to the user include those
impacting the SAS environment, servers, tasks, results and data. Also explained are the selections available when
applying individualized user preferences. Topics covered herein are applicable across all supported operating
systems. This presentation is designed not only for users new to Enterprise Guide and wanting to begin by using the
most efficient methods of project creation and processing, but also for the intermediate user looking to increase
project efficiencies in real world scenarios. The majority of these options have been utilized by the authors in
overcoming particular work challenges they have encountered during project development and reporting.

INTRODUCTION
Being able to readily adapt to dynamic business situations is the key to prolonged success and survival in today’s
market. SAS users old and new agree that, in addition to revolutionizing the look of the standard SAS application,
Enterprise Guide allows quick delivery of in-depth analysis in the form of reports and graphics. Often missed though,
is the extensive collection of choices within the Enterprise Guide environment that can increase our overall
effectiveness and create positive outcomes. The purpose of this paper is to communicate to the SAS community the
wide array of “Options” contained within SAS Enterprise Guide Version 4.1. Located under the “Tools” menu, the
“Options” item on the dropdown list provides a diverse assortment of settings accessible for specialized application
development. Alternatives offered to the user include those within the SAS environment, servers, tasks, results and
data. Also contained here is the ability to set individualized user preferences. The scope of these “Options”
encompasses the entire SAS Enterprise Guide application.
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EFFICIENCY AND ANALYSIS

TOOLS > OPTIONS > GENERAL

Include project name in exported filenames option automatically includes the name of the Enterprise Guide
project at the beginning of the name (separated by a hyphen) of any exported file.
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TOOLS > OPTIONS > GENERAL

Environment:
Reset Docking Windows: This is the quick and easy reset of docking windows for the Task and Server lists. This is
particularly helpful if a user has inadvertently closed the Task tab, Server tab or both.

SAS® Enterprise Guide® Implementation and UsageSAS Global Forum 2011

 
 



4

TOOLS > OPTIONS > GENERAL

Environment:

Number of items to display in recent projects menu: Users can specify the number of recently opened projects
that are displayed on the File menu. Conversely, selecting Clear History will remove all recent projects from display
on the File menu.
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TOOLS > OPTIONS > RESULTS > RESULTS GENERAL
Managing Results:

Enable or disable the display of the results and/or the log are available either in the Project Designer or Project
Explorer. An icon to these items will be created if these options are selected.
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TOOLS > OPTIONS > DATA > DATA GENERAL

Checked Box Recommendations:
 Use cell value to determine column type sets the column type as character or numeric based upon the

values in the cells of that column.

 Display columns in alphabetical order within the task windows and the Query Builder. All task
processing and display of results are not affected. The default displays the columns in the order which they
appear in the table.

 Use labels for column names in the data grid. Column labels can be also be added by right-clicking the
column heading and selecting Properties. For some tasks and corresponding results, this option is also
available.

 Display log for errors that occur while modifying data displays an error log if errors occur during data
operations on data in the grid. The data operations that can cause these errors include sorting data in a
column, inserting or removing columns, inserting data in the middle of a SAS data set, and copying SAS
data sets on the same server.

Unchecked Box Recommendations:
 As a general rule, but specifically when working with larger datasets, it is best to deselect the option that

directly opens datasets when adding them to the project. Because many of us routinely work with datasets
that contain tens of millions of records, adding one to a project that automatically opens can be both time
consuming and maddening.

 The same argument can be made for not automatically obtaining a record count for DBMS tables.

 Additionally, working with data tables in protected mode is advised.
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Default Action for Opening Data Files:

Open file as is radio button opens external data files without converting them to SAS data sets. (External data files
can include .txt, .csv, .xls, .dat, and .htm files.)

Always prompt to open file as SAS data set radio button prompts the user to use the Import Data task to convert
external data files into SAS data sets. External data files can include .txt, .csv, .xls, .dat, and .htm files.

Default Dimensions for a New Data Grid:

Default number of columns specifies the number of desired columns in the data grid when creating new data.

Default number of rows specifies the number of desired rows in the data grid when creating new data.
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TOOLS > OPTIONS > DATA > PERFORMANCE

Include schema information when saving data in text format checkbox should be left unchecked particularly
when working with large data files.

When accessing Excel data tables

 Use longest value as column width checkbox should be checked to include the greatest length value
within the column. The default column width is usually 255 characters if this option is deselected.

 Use first row as column names checkbox uses the first row of an imported Excel spreadsheet file as
column headings. Deselecting this option treats the first row as data.

Maximum number of rows to scan as a preview when importing data

To scan the entire set of the data, select No limit radio button. This option is not recommended for very large data
files.

 Limit number of rows to: radio button with list box specifies the number of rows to display as a preview, or
sample, in the Import Data task. This option also limits the number of rows that the Import Data task reads
from a text file in order to determine the format of the data.

Limit the number of distinct values of a parameter to (enter a value from 1 to 5000) list box specifies the
number of distinct values that are loaded when the Load Values option is used to generate a list of values for a
parameter.

Close data grid after period of inactivity (specify in minutes) checkbox and list box. This also releases the lock
on the open data. Twenty minutes (20) is the minimum value for this option.
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TOOLS > OPTIONS > TASKS > TASKS GENERAL

SAS procedure settings:

Users may choose to use PROC SQL to sort the data in tasks instead of using PROC SORT which is the default. For
large DBMS tables such as ORACLE, DB2 or TERADATA, it’s more efficient to use PROC SQL.

Filter unused variables:

Additionally, users can also improve performance by controlling whether unused variables are to be included in the
output data set. There are three options available for this setting -- Auto, Always and Never.

 Auto - is the default setting where SAS Enterprise Guide determines whether unused variables are to be
included as part of the input data

 Always - always filters the unused variables from the input data. If, as a result of running a task, an output
data set is created, the unused variables are also filtered from the output data set.

 Never - never filters the unused variables from the input data

TOOLS > OPTIONS > OLAP CUBE > QUERY

Optimize query results:

OLAP Cube options also allow users to exclude empty rows, empty columns or both from tables and graphs to
optimize query results.
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REPORTING

TOOLS > OPTIONS > RESULTS > RESULTS GENERAL

Result Formats:

Users have the option to select single or multiple output formats. Note that the SAS Report format option requires a
9.1.3 service pack 4 or better. This user has found that if the results are large it is best that the HTML option be
unchecked as this can cause delays when opening and/or closing a project; however, Enterprise Guide provides a
query option to limit the number of rows to save in the output and generate an HTML report.
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TOOLS > OPTIONS > RESULTS > VIEWER

The selection pane enables the user to select a category of options to view. To switch viewers from the default
(Associated Viewer), select the Preferred Viewer radio button and then click Browse to select the viewer.
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TOOLS > OPTIONS > TASKS > CUSTOM CODE

Additional SAS code:

Users can also insert custom code before and after the automatically generated task and query code for creating
standardized reports. For e.g. a macro to time each task and query when multiple tasks run as part of a process.
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TOOLS > OPTIONS > TASKS > OUTPUT LIBRARY

Default Library for Output Data (in order of search precedence):

Enterprise Guide lists the default libraries for saving output data in order of search and precedence in this option.
Users may add a department based library to the list and switch the order by clicking the UP/DOWN buttons so that
all output data is stored in the default location.
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TOOLS > OPTIONS > SAS PROGRAMS

Additional SAS code:

Users can also insert custom code before and after submitted code that is written in the Code Editor. This custom
code can be created and edited using the Edit button and is also used to create standardized reports.
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SECURITY

TOOLS > OPTIONS > SECURITY

Security features in Enterprise Guide provide the ability to mask passwords, save metadata credentials in user
profiles and mask credentials in the output log. It also allows clearing any credentials that may have been cached.

Credentials Persistence: Users can also set their credentials persistence to last for a specific length of time: either
per session, project, or user or not at all.
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ADMINISTRATION

TOOLS > OPTIONS > ADMINISTRATION > REPOSITORY AND SERVER

By managing the Repository and Server preferences, users can conveniently set up and switch between their
Development, Test and Production repositories. Each repository selection also lists the default servers associated
with it.

TOOLS > OPTIONS > ADMINISTRATION > E-MAIL SETTINGS

SAS Enterprise Guide uses SMTP (Simple Mail Transport Protocol) to send email as a step in the Project. Users can
specify the SMTP server name, sender’s email address and logon credentials here. If this information is inaccurate
and/or incomplete, then an error message is written to the log and no email is sent
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VISUALIZATION

TOOLS > OPTIONS > RESULTS > HTML

In addition to allowing the user to create and edit styles, this button offers a preview of the style choices and the
ability to change the default style.

TOOLS > OPTIONS > OLAP CUBE > TABLE AND GRAPH

OLAP Table Colors: OLAP row, column and measure header colors can also be set.
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TOOLS > OPTIONS > TASKS > TASKS GENERAL

SAS Enterprise Guide allows the creation of up to ten (10) customized default titles and/or footnotes for task output.
It also allows display of SAS procedure titles in results. The user simply needs to click inside the textbox provided to
create/edit the title/footnote text required.

In addition, it allows display of all generated SAS code in output including additional parameters such as the current
OPTIONS statements, ODS specifications, and LIBNAME statements.

SAS® Enterprise Guide® Implementation and UsageSAS Global Forum 2011

 
 



19

TOOLS > OPTIONS > SAS PROGRAMS > CLICK ON EDITOR OPTIONS

SAS Program Options also allows users to control the appearance of SAS log files, listing file, program file and text
documents.
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CONCLUSIONS
Due to the myriad of Options accessible within Enterprise Guide, each one cannot be covered in this presentation;
however, it is the goal of the authors to give an overview of the many possibilities that exist. Demonstrated within
this presentation will be ideas for practical use to achieve maximum return on investment. While designed primarily
for the SAS Enterprise Guide novice, it is expected that some insight can be gained by even the SAS Enterprise
Guide expert. Many of these tips derived from applied use situations that have arisen during concept and design of
Enterprise Guide projects. Although the authors work with many highly skilled users from legacy SAS tools (Main-
frame and PC SAS), the ease and simplicity of the Enterprise Guide application has brought them together with an
entirely new group of potential SAS users. It has been in working with these newcomers to Enterprise Guide that the
authors have found first impressions are often the “make or break” points for defining whether a new user will con-
tinue working in the Enterprise Guide environment. Having the most efficient settings and options selected can de-
termine the future success for a beginner to Enterprise Guide. By knowing the options, making thoughtful, business-
savvy decisions and instituting a uniform initial set up in Enterprise Guide, organizational standards can be estab-
lished early in the development process; thus allowing for increased productivity.
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